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ABSTRACT

Transportation agencies use many computer tools for managing infrastructure. Engineers in
operating divisions at the lower end of the organizational hierarchy choose a variety of tools to meet their
specific needs. Managers at the top of the organizational hierarchy want a uniform “enterprise” database
system that provides them direct access to agency-wide data. Frequently, these two different approaches
at different levels cause inefficiencies in the agency. This study was conducted to determine if
efficiencies could be gained through the process of standardizing data storage mechanisms to permit
diversity at the operating level while maintaining data compatibility for aggregation at higher levels in the
organization.

A needs assessment regarding pavement inventory and maintenance scheduling conducted at the
regional level provided the information for developing a computer-based tool for operations. The needs
at headquarters for aggregating data were accommodated by exposing regional data in standard database
(.dbf) formats. A variety of visual development tools were considered for the project. Borland Delphi™
was selected because it provides satisfactory connectivity for enterprise as well as local database back-
ends, it provides a powerful development language (object Pascal) for engineering algorithms, and it
provides an exceptionally good Integrated Developers Environment.

The Pavement Preservation Prototype software consists of three coordinated sections: Pavement
Treatments, Paint Treatments, and Maintenance Management Quality Assurance. Each section was
provided with a custom Graphical User Interface in conjunction with a standard database back-end.
Because the data were converted and exposed in a standard format, straight forward GIS analyses could
be applied. Examples provided for each of the three prototype sections demonstrate the advantages of

standardizing regional data.






PAVEMENT PRESERVATION SYSTEM
CONVERSION AND ENHANCEMENT PROTOTYPE

Project Objectives
Needs assessment at the regional level: Pavement inventory and scheduling needs at the regions
will be assessed. The regions are the operating level in the pavement information systems
hierarchy. All data collection and primary analysis are conducted in this level. Hence a system
that aids in this process must be developed. The primary attribute of such a system should be
user-friendliness. Another desirable feature would be to develop a system that encompasses
existing pavement preservation methodologies.
Needs assessment at the headquarters level: Headquarters is the level where all regional
pavement databases are’ aggregated and statewide data analysis is facilitated. At any given time
the regional databases must be accessible to the headquarters. The model should allow retrieving
data from different data sets in an efficient manner.
Develop architecture strategy: This objective entails fulfilling the needs at the regional level and
headquarters level. Objectives at this level would include data concurrency and multi-user access.
Data concurrency ensures that data at both the regional and headquarters level are the same while
preserving data integrity. Multi-user access allows multiple users to access the same data
simultaneously. This would also prevent multiple copies of the same data.
Develop prototype applications: Prototypes must be developed for the pavement databases. Data
structures will be defined for storing data appropriately. The application should be designed to
ensure smooth transition between current practices and proposed practices. Demonstrate
prototype: The prototype will be tested to demonstrate the pros and cons of the approach and to

provide insight for implementation.



Development Tool Selection

Leading development tools for information systems were reviewed to insure that state-of-the-art

technology would be used for the prototype. The following three terms are used by the industry and

throughout this report:

1.

Back-end applications: The back-end application is where the data reside. It also is
known as the server; any computer process providing services to the client. The server
processes provide background services for the client process. At one end of the spectrum
are large enterprise database servers, such as Informix and Oracle. At the other end of
the spectrum are local databases such as Access and Paradox. Microsoft SQL Server
capabilities lie somewhere in between.

Front-end applications: The end-user usually interacts with the client process. The client
is any computer process that requests services from the server. The client also is known
as the front-end application. Modern software products for the development of the fronz-
end commonly are referred to as “Visual Development Tools.” The current principal
competing products on the market are: Borland’s Delphi, Microsoft Visual Basic, Sybase
PowerBuilder, and Symantec Visual Cafe.

Middleware applications: Middleware is any computer process through which clients and
servers communicate. The middleware is made up of several layers of software that aid
the transmission of data and control information between the clients and the servers. The
communications middleware usually is associated with a network. All client requests and
server replies travel through the network in the form of messages that contain control

information and data.

Microsoft Component Object Model (COM) and the Object management Group Common Object

Request Brokered Architecture (CORBA) are competing architectures for addressing the problem of how

to define, construct, and deploy software elements that comprise complex systems. Both architectures
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attempt to achieve database server independence by allowing front-end applications to access data from
multiple server databases without the need to write separate specific code for each database. CORBA
implementations support a wider range of languages and platforms than COM. In contras‘;to COM,
CORBA was designed specifically for distributed systems. However, COM and CORBA seem to be
converging toward a consensus industry standard.

State-of-the-art visual development tools are used for developing middleware and for developing

the front-end applications.

Evaluation of Development Tools
Visual Development Tools
Visual development tools are used for the development of front-ends and middleware. A World
Wide Web search was conducted to gain current evaluations of the principal visual development tools:
Borland’s Delphi, Microsoft Visual Basic, Sybase PowerBuilder, and Symantec Visual Cafe. The
following six sites were selected in an attempt to provide a balanced summary:

. PC Magazine (www.zdnet.co.uk/pcmag/labs/ 1999/04/visual/004.htm!), which contains

the most up-to-date, in-depth, independent comparative evaluation that we could find.

. BYTE Magazine (www.byte.com/art/9611/sec12/art6.htm), contains an independent

comparison of Delphi, Visual Basic, and PowerBuilder.

. Microsoft (www.microsoft.com) because Microsoft produces Visual Basic. Its web site

contains an in-depth comparative evaluation of Visual Basic, Delphi, and PowerBuilder.

The evaluation was prepared by NSTL, Inc.

. Sybase (www.sybase.com/products/powerbuilder/gigaart.html), which produces

PowerBuilder. Its web site contains a cursory comparison of PowerBuilder and Visual

Basic.



. Borland (www.borland.com/delphi/papers/delvspowr/delvpowr.html), which produces

Delphi. Its web site contains an in-depth comparison of Delphi and PowerBuilder.

. Symantec (www.symantec.com/vcafe/index_reviews.html), which produces Visual Cafe.

PC Magazine

This section reviews the evaluation of visual development tools published by PC Magazine. This
is summarized in greatest detail because it is the most in-depth independent comparative evaluation
available at the time that this study was conducted.

. Value for Money: Though Delphi and Visual Basic were close in terms of pricing and
features, Delphi achieved higher usability and features scores as compared to Visual
Basic and PowerBuilder.

. Help Information: Delphi and Visual Basic code prompts and online help were
straightforward. PowerBuilder suffered from more erratic help information.

. Satisfaction: This index illustrates the consistent qualities of the products tested. Visual
Basic and Delphi both achieved high scores on this index. PowerBuilder’s confusing
interface and lack of examples affected tester’s perception of the product.

. Form Design: The testers found that creating Delphi forms was simple. Visual Basic also
scored high, but faced some criticism for its time-consuming process of changing
component properties. PowerBuilder received mixed reactions. Some features got an
excellent rating, such as the ability to preview the form without having to run the project.
However some features could be awkward for new users since the interface and
associated help files don’t make it clear where to find controls and tools.

. Reading from a database: Testers were asked to connect forms to a single table DBF
database containing 21 columns and 8,400 rows of data. Delphi’s database wizard

simplified the procedure, contributing to the product’s overall productivity scores.



Making the initial connection between the database and its associated form was more
awkward in PowerBuilder. Lack of good help affected PowerBuilder’s scores in all
usability indices. However, once the databases were incorporated, PowerBuilder was
found to have one of the strongest set of tools for database related applications. Options
for creating reports and labels were appreciated.

. Adding event code: Delphi automatically added code into the project. This reduced the
amount of code creation that testers had to complete. However lack of comments for such
generated code hampered debugging programs. On the other hand, PowerBuilder
required manual operations to carry out many tasks automated in most other packages.

. Compiling and debugging code: Testers found debugging Delphi source code difficult
due to much of the code being generated automatically. By contrast, Visual Basic
provided easy-to-use debug facilities. PowerBuilder, with its lack of help and confusing

controls, ranked low.

BYTE Magazine
The article “Upgraded C/S Tools: How Much Better?” included Visual Basic, Delphi, and
PowerBuilder. The article “New Leaders of the Client/Server” included Visual Basic, Delphi and
PowerBuilder. The context of the articles could be summed up by the “Making a Choice” section in the
second article:
But good as {Visual Basic and PowerBuilder} are, Borland's Delphi takes top
honors. Developers will find its procedures for form design and accessing of
components similar to Visual Basic's, but in many little ways Delphi simply
makes it easier and more convenient to access data from a client/server database.
And its speed, both in database and non-database operations, is far ahead of all

the competition.



Microsoft

Microsoft commissioned NSTL, Inc. to prepare an in-depth comparative evaluation of “Rapid
Application Development Tools” including: Visual Basic, Delphi, and PowerBuilder. A qualitative

summary of their “Usability Results” would rank Visual Basic first, Delphi second, and PowerBuilder

third.

Sybase

Sybase provides a cursory comparison of Visual Basic and PowerBuilder in nine categories:
productivity, cross-platform support, skills availability and third-party support, general ease of use,
support for three-tier architectures, performance, Java support, size and complexity of applications, and
cost of deployment.. A qualitative ranking of their comparison gives Visual Basic four “strongs” and five

“weaks,” and gives PowerBuilder seven “strongs” and two “weaks.”

Borland

Borland commissioned Sphere Data Systems, Inc. to prepare an in-depth comparative evaluation
titled “A Comparison of Client/Server Development Tools; PowerBuilder vs. Delphi.” The two products
were rated on performance, Rapid Application Development (RAD), database application architecture,
client and server tools, and user interface. The paper concludes that “Delphi surpasses PowerBuilder 5.0
when it comes to performance, ease of use, object oriented technologies, database access, client/server

rapid application development, and scalabiltiy.”



Symantec
Symantec does not provide any comparisons between itself and its competitors. Symantec
announces that Visual Cafe offers excellent performance and features for new Java developers wanting a

RAD environment with client/server database support.

Development Tools Used for the Prototype

Back-End Tools

Two distinctive categories of database back-ends exits: “enterprise” and “local.” Two of the
leading enterprise database tools are Informix and Oracle. Théy are intende& for storage and
manipulation of huge amounts of data. Consequently, their implementation and maintenance require a
huge investment in time and money.

Local database back-ends, like Access, Paradox and dBase, primarily are intended for use by an
individual or a small group. They are relatively inexpensive and easy to learn. dBase was the first local
database to dominate the market. dBase file formats (.dbf) are still the common denominator for sharing
data between databases. However, the dBase commercial product essentially has become extinct.
Microsoft Access has acquired major market share in recent years.

The applications for this project are intended for use by the UDOT Regions. An enterprise back-
end, such as Informix, is not available locally at the Regions. Besides, an enterprise back-end would be
over-kill for a project of this scope. However, Access is available at both Region 1 and Region 2 — the
sites where prototypes would be guided and evaluated.. Therefore, Access was the back-end chosen for
the project. Part way into the project UDOT requested dBase format files so data could conveniently be
imported to ArcView and other applications. dBase format files then became the back-end data formats

for this project.



Front-End Tools:

As described in the previous section, the principal competing tools in the marketplace for front-
end development are Borland’s Delphi, Microsoft Visual Basic, Sybase PowerBuilder, and Symantec
Visual Cafe. All four currently are being used extensively in practice. Delphi was selected for the
following reasons:

. Visual Cafe was not chosen for several reasons, but primarily because it is specifically

tailored for Java applications, and Java was not required for this project.

. PowerBuilder has a strong user base that was built up in the past when PowerBuilder was
the best and most widely accepted front-end development tool for large scale client/server
applications. It is intended for use with large enterprise database systems such as
Informix. It is relatively expensive and has a long learning curve. It supports MS
Windows, Mac, and UNIX. It is not intended for development with local database back-
ends such as Access. It is not commonly used by university students, and is never used by
engineering students. PowerBuilder was not highly rated in the independent reviews.

. Visual Basic is emerging as a powerful visual development tool for client/server systems.
It is relatively inexpensive and has a short learning curve. It can be used to develop front-
ends for enterprise database back-ends, such as Informix, as well as for local back-ends
such as Access. In addition, it is the basis for Visual Basic Application, the consistent
macro language for all Microsoft Office Products. It is the most prevalent computer
language currently being taught to engineering students. It only supports MS Windows.
It was rated high in all independent reviews. Visual Basic is becoming a tempting
alternative for front-end development over a wide range of information systems
applications.

. Delphi has many of the same attributes as Visual Basic (VB). VB is judged better in that

Delphi has a slightly longer learning curve and is not used by university engineering



students. On the positive side, Delphi provides class structures similar to C++ and Java
that are not available in VB. Delphi was rated high in all independent reviews. Because
of its all-round performance capabilities, and its similarity to the C++ computer industry

standard, Delphi was selected for development of the front-ends for this project.
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PAVEMENT PRESERVATION PROTOTYPE

Background

Pavement Preservation currently is done in unison with paint preservation and the Maintenance

Management Quality Assurance (MMQA) program. The roads are divided into segments based on

beginning and end mile posts on a given route for a controlling station. All the pavement, paint and

MMOQA attributes are keyed to these segments. Data is stored in sequential order in a Quattro-pro file.

The screen shot below captures part of that Quattro-pro file. As can be observed, data is entered in rows.

No structura) separation exists between the pavement attributes and the paint attributes.

B Corel Quattio Pro - D:\Chandra\Region2\PPP\junk.wb2
=l Fle Edt View Inset Fomat Tools Window Help

=] E3
=18 x|

DwEHdESdB0

YDA HAR AZEBEH X-82

[avial ~2 =l [BZ UlNomd - E-E-|B-R- @
;[ Data:U12 B [1999 : o
R | s i T I U i ¥ | w ]
: e
. | Plan for Every section of Every Road
3
4
5
6 (Based on field Review)
1 PAVEMENT
8 SCHEDULED SCHEDULED PLANNED PLANNED 148T IASRT
4 TREATMENT TREATMENT . TREATMENT TREATMENT PAINT-TREATMENT FPAINT TREATMENT
‘10 TYFE YEAR TYFE YEAR TYFE YEAR
1 §
2 REJ 1999 REJ | 1999 | SOLVENT 1996 E-
B REJ 2000 REJ 2000 PAINT 1996 E.
“ REJ 1999 REJ 1999 EPOXY 1996 E
5 REJ 1998 cs 2001 EPOXY 1996 E
1s REJ 1998 cs 2001 EPOXY 1996 =
K REJ 1999 [ 1999 EPOXY 1985 E
ss REJ 2003 REC 2000 SOLVENT 1996 E
19 REJ 1998 cs 1999 EPOXY 1985 E
20 REJ 1998 cS 2000 EPOXY 1995 E
21| OVERLAY 1998 REC 2000 F_Zj
ARBEE) Dst= = [Mac = JF o a5 ant Can
*Notebk1.wb3 [junk . wh2 1 |READY A4

Figure 1. Quattro Pro Spreadsheet Data Entry and Analysis Form
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Though pavement management using a spreadsheet brings with it advantages such as ease of use,

familiarity of personnel, it has several shortcomings which must be overcome. A few of those

shortcomings follow:

Data, essentially spatial in nature, is not readily accessible to a spatial representation like
a GIS.

Multi-user environment may lead to Data Redundancy (multiple copies of the same data).
Difficult to consolidate data from multiple users.

Data security not enforced rigidly.

Not intended for large data sets.

Difficult to query and filter data.

Complex macro language that is difficult to maintain and debug.

Merging data from several regions is awkward and prone to error.

A model was needed would overcome the aforementioned pitfalls and still maintain functionality

of the existing program.

Functionality for the Prototype
Data Display: The prototype should allow easy display and access to records. Navigation
through the records of a database table should be in an efficient and user-friendly manner.
Data Manipulation: Key data manipulation operations such as insert, update, and delete
should be easily facilitated by the model.
Order of Information. Information is defined as “processed data.” The prototype must
allow for sorting data in an order defined by the user.
Information Retrieval: Many a time, specific information must be retrieved from data.

The prototype should possess good querying abilities.

12



. Data Storage: The format in which data is stored is an important issue. Data storage
should be in a form conducive for various development tools to access it.
. Data Analysis: Data analysis is an offshoot of the previous need for standard data

storage. Data must be amenable for analysis using tools such as ArcView GIS.

Approach Adopted

This section details the approach adopted in meeting needs for the pavement preservation model.

Data Standardization

The emphasis was on data standardization. All data were converted into the standard format.
Once data is in the standard format, migration to any other format becomes easy. Also database
development tools can access such data to perform various analysis and manipulation. dBase was chosen
as the standard platform as it is the generic database which can be accessed/ translated into any other
database with ease. dBase is a good fit in the architecture proposed, which calls for eventual transfer to an
enterprise database. dBase can be used with a base level database such as access or an enterprise system

such as SQL Server.

GIS Interoperability

All pavement management data is spatial in nature. Each of the road segments for which
attributes are stored corresponds to some specific geographic location. Keeping this fact in mind, the
prototype was developed to work well with a Geographic Information System. ArcView was the GIS tool
adopted. dBase tables are the standard format employed in ArcView. For this reason the pavement

management prototype is interoperable with ArcView.

13



Determination of Data Structures
The pavement management database was organized into different topical modules. Therefore
there are tables dealing with data about pavement treatments, paint schedules, MMQA, pavement

evaluation and so on. Each of these tables has a mirror table for storing archived information. A list of the

tables and the fields contained in them is provided in Appendix A at the end of this report.

Data Entry and Manipulation
Specific input screens were developed for data entry and manipulation. These dialog boxes are
better than entering records in rows for the following reasons.
. Chances of data entry errors are minimized as the dialog box is focused on one record
and selected special fields.
. The user need not go over the whole row if only a few values are to be entered.
. Choice of values for certain attributes can be restricted by the use of drop-down boxes.
This ensures that the user does not input undesirable values.

. Access to these dialog boxes may be restricted, thereby increasing security.

Information Retrieval and Ordering
The prototype introduces improved querying and sorting capabilities as opposed to the
spreadsheet. Easy to use interfaces have been built which allow for data to be queried and sorted. Such

tasks would have involved cumbersome clipping and pasting in the original spreadsheet environment.
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PAVEMENT PRESERVATION MODEL EXAMPLE

This section deals with implementing the pavement management prototype to a real ‘world
pavement preservation program. The emphasis is on illustrating the methodology and benefits accruing

by using this model.

Data Display
The opening screen shows the display of data already contained in the pavement table. Tools

have been provided to navigate through the record with ease.

A Control Intesface - 0] ]
¢ File: ‘Edit - Add Tools . : et 0

General  Treatments IPainl ] Eyaluationl MMQA]

‘ o l . e T |
: ismmn [ROUTE  |BEGIN_MP [END_MP |LST_TRE_TY  [LST TRE YR[SCD_TRE_TY ISCD_THE_YL_A_I |
§l B8 0 104 R 1988 _REJ 12001 ‘
L2 o 0 1w REC 1ssy R 2000 :
|l e0 0 20  REC  19%  RH 1933
[ 22 80 20 30 REC 195 REJ 1938

21 8 30 0 REC 1995  REJ 11998
222 80 40 56 REJ 1% IREJ 1933 :
| 222 .3 631 66.4 ss . 1s2  RES 1985 |
[ o2 80 56 69.4 REC 1994 REJ 1997

222 B0 684 & G 13%5  REJ 1938

222 80 89 946 cs 1995 REJ 1938

222 80 94.6 71 _None - : U»nknown N
(22 s0 971 w02 CUR 186 CJR 2006 -
| |22 o 1w ss 1% RE 19
(22 138 10 n2 s 1334 RES 18w o
[ j222 18 M2 04 0SS 182 RE 1935
(Je22 1% 0 71 ss 18 RE 1997 e
222 198 171 244 : o

w

0 sl

Figure 2. Database Display of Data by Category.
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Data Manipﬁlation
Pavement data is always dynamic. Records are to be updated constantly to keep track of surface
treatments and schedules. A history of such changes also must be maintained to provide an idea about
pavement durability and can be invaluable for various analysis such as life cycle analysis and benefit-cost
studies. This archiving facility was lacking in the spreadsheet model which is rectified in the prototype.
The tool for data manipulation brings up the following dialog box. The fields in the dialog box are
populated by values corresponding to the location of the cursor in the main form. Refer to the previous

screen shot to locate the cursor position.

T 1]
Treatments Database
Station [221 Scheduled Treat. Type |REJ ~|
Route [58 Scheduled Treat Year [2001
Beginning [0 Ilanned Treat. Type |REJ ~]
Ending |1.54 Planned Treat. Year EUEH
Last Treat Type Surf. Area |0
Last Treat Year [1399 Cost Treatment |0
Lane Miles |1.54 Comments |

Figure 3. Data Entry Dialog Box.
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Notice the drop down boxes for the treatment types. These will ensure that the user will only use
the specified treatment type, eliminating the possibility of an error. The post button on this form performs

two functions.

D The main form (opening screen) gets updated showing the latest values, and
2) The old values are stored in an archive table which can be viewed conveniently as shown
in Figure 4.

A &rchives

~General

IB[=1 E3

|| Paits | Evaluation | MMGA |

L T e ]

] < | >
[station [route  [BEGIN_MP [END_MP |LST TRE_TY |LsT_TRE YR|SCD. TRE_TY - |SCD_TRE_YR{Pl4]
M = 5% 0 15405 ... 1e:3REJ 2001 RE.

Figure 4. Display of Archived Data.

Ordering of Information
The prototype allows flexibility to order data depending on the constraints decided upon by the
user. For example, the user might want to see all data grouped by the routes and see the last treatment
type as a sub-group. The order of sort can easily be defined by using the sort tool shown in Figure 5. In
this example the user has designated a sort based on a primary field of “Route” and a secondary field of
“LST TRE_YR” (last treatment type).
The results of the sort are shown in Figure 6. It shows the table sorted in the precedence of routes

and last treatment types. A sort also could be conducted on planned treatment years. This would give an
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idea of the tasks at hand and help in prioritizing. Thus, ordering of data is a useful tool in planning for

pavement treatments.

Multiple Sort X ] l

_ Choose from Table IPavement v[
Source List ' Destination List:
|STATION : ROUTE
- |BEGIN_MP LST_TRE_TY
|END_MP N I
[TST THE YR
|SCD_TRE_TY ~ -
SCD_TRE_YR w22 - ——
PLN_TRE_TY L
PLN_TRE_YR < e
LANE_MILES —
SURF_AREA
COST_TREAT _<<_J
|COMMENTS
ok | cancel ] “Heb

Figure 5. Dialog Box for the Sort Tool
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)é Sorted Table [ _{O] X]
Eile

[[sTaTion [ROUTE _ [BEGIN_MP JEND_MP [LST TRE_TY [LsT_TRE_YR|[SCD_TRE_TY  |SCD_TRE_YR]~
P 15 3217 3223 CREC 199 C_JR ‘ 2006 _
| 22 15 288.7 291 C_REC 19B5CHR 2008
|| 2 15 2% 304 None 198 Unknown :
| 25 15 307 3108 None Unkmown
| 2 15 291 2%MNee  Unknan
| 25 15 3we  N2PMsC  1%6RES 1999
| 26 15 32 F7PMSC  19BRE) 1999
] 2 15 we  s7PMsC  186RE) 1999
= 15, 34  37PMSC 1988 AR 1991
| | 2 15 a7 318'REC o 1997REJ .. 2000
| 237 2 13 2086 CS 199 RES  19%
| | 236 % 2096  2835CS I 19%RE) 198
| 237 % 13 128 §
| 27 % 0 101CS o 1w5REL e
K 223 3% 64 142 :
1 23 % 142 199 )

223 % n 4 B
| 23 s 83 BESPMSC  1993RE) 199
[| 23 o s  e3uss 0 1992RH f 1935_111

Figure 6. Results of the Sort Based on the Parameters Specified in Figure 5.

Data Retrieval
Data Retrieval, as opposed to data sorting, is used to filter data. Only those records that satisfy a
given condition are returned. Complex queries can be performed using this model. For instance, the user
might want to see all the segments due to be treated in 1999 and due to occur on route 15. The query tool

is put to use in such cases.
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< Query Tool ' — 5T
©' Choose from Table lPavement 1-[ ‘ o

Values Available : -

Flefds Available * VeluesAvallable. .
END_MP <] _|sco_tRe_vR| ] -
LST_TRE_TY 1995
LST_TRE_YR g Ty
SCD_TRE_TY =| > | »=| and

PLN_TRE_TY )

PLN_TRE_YR Dl B B

LANE_MILES

|SURF_AREA

COST_TREAT  ~|

ROUTE = 15and SCD_TRE_YR = 1933

Figure 7. The Dialog Box for the Query Tool.

S FResult B I=] E3
- File “Todls k L e e
[ TsTaTion [ROUTE.  |BEGIN_MP [END_MP JLST TRE_TY  [LST_TRE_YR[SCD_TRE_TY  [SCD_TRE YR]~
s 15 3108 312 PMSC 1996 REJ
' 15 N2 317 PMSC 1% RES .
o 15 318 3217PMSC 1936 REJ
| P

Figure 8. Results of the Query Based on the Parameters Shown in Figure 7.

Data Analysis
Analysis and graphic display of pavement data can be efficiently performed using a GIS tool such
as ArcView. The single biggest advantage of a GIS is that it lets the user visualize information in new

ways that reveal relationships, patterns, and trends that would otherwise be intangible in a tabular system.
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UDOT’s pavement data was analyzed using ArcView. Numerous demonstrations of its power were made
at UDOT seminars. The following series of screen shots show how GIS can be integrated with the
pavement preservation model.

Figure 9. shows the GIS display of the road segments maintained by Region 2 in dark black. Utah

State Highways are shown in gray.

: " ArcView GISersxo 3.0a
Edit. View  Iheme Graphics * Window Help T

-_.--- 8 B APAED ® B0 E

5“'“]———7—- 4@%9%; t

ﬂ Aocboshp el
| o Pavement.dbt

o>

(] Paintdbf
|~ A/z00

T Treatmentshp
20041
2002

: I 'Paintshp A
] Mmqa.dbt - {-
| “Evaluation.dbf = !’

Figure 9. GIS Display Showing State Routes in Region 2.
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Figure 10. This screen highlights roads that are due for surface treatments in the year 2000. These

roads are shown in thicker lines. In this way, at a glance the manager can tell which roads are due for
treatment planned for the year 2000, and can further prioritize tasks and schedule work among the

maintenance crews.

«f,' ArcView GIS Version 3.0a

1 «] Paveme nt. dbt |

/142000

.

| I Paint.abt
: /\/ 2000
]I Treatmentshp
k2001
1712002
A2 Pa‘i.l"‘l/tsltip

-

14 Mmqa. dbf

g0 Evaluation.dbf s i 4

| 1 seneiaLabt <l
. Provides information about a feature , o ‘ SR et e

Figure 10. GIS Display of Surface Treatments Planned for the Year 2000.
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PAINT PRESERVATION MODEL EXAMPLE
The Paint Preservation Model (PAINT) is similar to the Pavement Preservation Model (PAVE).
Data are stored in a standard format. This makes the Paint preservation model readily amenable to a GIS
analysis. Specific data manipulation dialog boxes have been built to provide the user with an easy
interface. The following series of screen shots summarize the paint preservation model.

Figure 11 shows the PAINT database. Customary tools have been provided for navigating

through the records.
ﬁ Control Interface [ 101 %]
File "Edit -Add . Tools
Genera|| Treatments ffg:ﬂlr,l Evaluélion] MMQAI
i | # l > | <3 |
STATION |ROUTE  |BEGIN_MP [END_MP [LST_PT_TYP  |LST PT YR[SCD_PT TYP lsco_PT_Ynliff‘J
221 58 0 154 SOLVENT 1996 'SOLVENT 11997

21 8 0 10 PAINT ~ 19% EPOXY 2000
21 80 0 20 EPOXY  19% EPOXY 1939
221 80 20 30 EPOXY  19%  CEPOXY 1938
221 80 3 40 EPOXY  19%  EPOXY 1988
221 8 40 5 _EPOXY 188 EPOXY 2000
22 38 631 8B4 SOLVENT 1996 EPOXY 1997
222 80 56 684 EPOXY 19% EPOXY 188
2 80 B84 8 _ EPOXY 1935 EPOXY 1997
22 80 8 946 . ERPOXY 1997
222 80 w46 97 EPOXY 1935 EPOXY 1988
222 .80 971 102 EPOXY 1393 EPOXY 1988
222 138 0 10 EPOXY 193  EPOXY 1399

}
;

H
;

[ [ , : |
L.]_rnarn mmmmmmmmmmm.mm.m

ez 1m0 m2  EPOXY 18 EPOXY 1838

ez 1 vz e e e EPOXY 198

| {222 196 ] 71 EPOXY ! EPOXY 1939
2w e : |

| - ¢ s

Figure 11. Input Dialog Box for Manipulating the Paint Data.
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A Input Interface M=} E3

Paint Database
Station rﬁ'—_—_' Scheduled Paint Type |SOLVENT Ed
Route |58 Scheduled Paint Year 1997
Beginning [0 Actual paint Type [EPOXY R
Ending [1.54 Actual Paint Yesr [2000
Last Paint Type [SOLVENT  ~] Lane Miles [0
Last PaintYear [1996 Comments |

Figure 12. Dialog Box for Inputting Data to the PAINT Database.

The PAINT database also has the following features:

. auto archiving on post

. ability to perform multiple sorts on the database

. ability to query the paint database

. ability to generate tables derived from the main database. Refer to the user’s manual
section.

The PAINT database also can be analyzed using a GIS as shown in the following exhibits.
Figure 13 displays the roads in Region 2 graded by the different paint types.
The database and GIS analysis also can be used to create charts and graphs as shown in Figures

14 and 15.
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£ ArcView GIS Version 3.0a
Ele  Edt. View Iheme Graphics - Window Help

.JI
Illllﬂllllﬂ“l!MMIEIIIH!lHl
B & BK8) BN AR LD AT

(OD [ DREFE T oT] -]

: b,.e‘ Viewl

ﬂ Paintshp

/\/EPOXY

PO LYCARB &

NSOLVANT
NS Teee .
o] Treatmentshp .

72004
2002 : Wk

.} Paint.dbf : A
|~ Afmo ]
) cag , 1
N ~.
i P vement.dbf
2000

__l Mmqa dbf

_J__Enl.ua.ﬁ.nn.dhi |

o
o

Figure 13. GIS Display of Paint Types in Region 2.

( £ ArcView GIS Version 3.0a
‘Ele  Edit . Gallery ~ Chart - Window Help

‘ Paint-2000 Profile
Profile

W EPOXY (89.17%)
TAPE (31.33%)

Paint Distribution

Figure 14. Graphic Display of the Paint Profile Planned for the Year 2000.
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£2 ArcView GIS Version 3.0a H=]E3
; Eile ~Edit Gallery  Chart  Window - Help . : )

B ] MEre)l:]

Mlles of Paint Year-Wise

350

W 1999

303 2000

2 M 2001

~ Miles fgg O 2002
~ M 2003
100 02004

58 ] 02005
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[
(BN

Figure 15. Graphic Display of the Miles of Paint Applied by Year.

Figure 15 is a graphic of the miles of paint planned for application by year. The values have been
computed from the database, and the results are shown in the form of a bar chart.

Figure 16 is a graphic displaying the power of GIS to relate data from disparate databases and
perform an analysis. Here the single dashed lines are pavements scheduled for painting in the year 2000.
The double lines are pavements scheduled for treatment during years 2001 and 2002. The overlap of these

lines show pavements which will be treated within two years after striping.
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f } ArcView GIS Version 3.0a

File  Edit - View  Iheme - Graphics
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Figure 16. GIS Display of Pavement Overlays and Pavement Striping.
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MAINTENANCE MANAGEMENT QUALITY ASSURANCE EXAMPLE

Introduction
Each Region and Station is responsible for assessing the quality of its roads. This Maintenance

Management Quality Assurance (MMQA) process is accomplished by randomly selecting segments of
roads, visually inspecting the segments, and grading the results on a scorecard. The scorecard is divided
into 10 groups:

1) snow removal

2) hard surface maintenance

3) non-hard surface maintenance

4) roadside maintenance

5) vegetation control

6) drainage and slope repair

7) major structure maintenance

8) traffic services

9) supervision, training, and support maintenance

10) rest area maintenance
Each group contains several activities. Performance measures are specified for each activity. Scoring is
accomplished by rating the performance measure for each activity on a scale from Av(high) to F (low). A
complete list of groups, activities, and performance measures is presented in Appendix C.

UDOT developed a Quatro Pro spreadsheet to help station personal conduct scoring in the field.

The spreadsheet generates random numbers for selecting road segments, and provides dialog boxes for

scoring each activity.
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Region 2 added columns to their Pavement Preservation spreadsheet in an attempt to consolidate
Pavement Preservation, Paint Preservation, and Maintenance Management Quality Assurance into a
unified software suite that could be used by the regions.

The objective of this part of the project was to demonstrate an alternative to the spreadsheet, and

to present some of its advantages including interaction with Geographic Information Systems (GIS).

Database Approach
The dialogue boxes of MMQA data can easily be replicated in dBase using standard tools. Figure
17 is the highest level dialog box showing the general information and the randomly selected route

segments in the spreadsheet. The main advantages of dBase files over spreadsheets are as follows:

Accessability to Data

The dbase files can easily be linked with ArcView GIS. Numerical data can be viewed in two
dimensions. A two-dimensional picture gives a detailed overview of the data which can be useful to the
people in the field. The database format reduces the time and effort needed to generate a geographical
display showing the spacial distribution of the scorecard values. Figure 18 shows the region on the

standard state highway reference system.

Analysis of Sata Made Easy

With the two dimensional/route map available in ArcView, the data can be analyzed further,
which will give a detailed output. Any type of analysis can be made on the data and any number of
additional attributes can be linked with the data available. For example, the attribute length of route can
be added to make the tables more self-explanatory. Also one can make an analysis such as which part of
the county has maximum traffic or which part of routes require MMQA treatment and so on. These

analyses make the data more useful and efficient. This also could save some time and effort of the site
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engineers who go out to collect the data which can be evaluated on the desk by conducting analysis in

ArcView. Some of the analysis done on MMQA is shown in Figures 19 through 22.

31



Headings1 [2]x]
- MMOQA Program Service Level Worksheet

*-Tum Print Off 7 On

: " EwtryDate: -~ Station: i 7i1421‘ o (PRINTON
s S o G PRINTOFF .~
iz S :J 833 " Region/Distreit: Region1 R STERE

: . T SanplePeiod————
Area: CLINTON o T CYSPRING T
Nuwmber of Lanes: | 2 ﬂ k @FALL‘

- Route RaNAOM NI i ot

# Fovte 37 Bandom 010 " A
| Route 37 Random 0.80 :
Route 37 Random 2.20
| Route 37 Random 7.60
Route 37 Random 9.20
Route 39 Random 0.80

Route 39 Random 1,30 L o
Route 37 Random 040 et !

 NO MORE |

EVgluaton [

o General Cohment; ;

o Mman e o
o Cag
N

Figure 18. Sites for MMQA Data for Region 2.
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Figure 19. Display of MMQA Data Field “Asphaltholes”.

Figure 19 shows ratings for the MMQA parameter “Asphaltholes” on the State Highway Route
map. This type of information is useful for prioritizing and scheduling. Figure 20 shows information

from Figure 19 plus a character (A through F, or N/A) representation of the score for the respective route

segment.

Figure 21 shows similar data for the MMQA parameter “Concreteholes” plotted as bars.
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Figure 20. Display of MMQA Data Field “Asphaltholes” Showing Character Score.

2 Viewl

P ———
off ‘Conovete holes 4]
Beginning:" |

'—H

Figure 21. Display of MMQA Data Field “Concreteholes”.
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2 ArcView GIS Version 3.0a
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Figure 22. Table of Attributes Displayed by the Identity Tool.

Data Queries
The simplest way to access data is to use the GIS Identity Tool. As shown in Figure 22, the

identity tool in ArcView gives all the attribute information on screen for any route selected. Again this is

an efficient and handy tool for the site engineers.
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The query tool is the main tool used to answer most of the questions during analysis. For example
in Figure 23 and 24, with the help of this tool one can find a particular route or all MMQA treatments
required in a particular year. Multiple queries using Boolean values, like “and,” “or,” “>,” “<,” etc; can be

used where more than one attributes is to be used to find an accurate solution.

& Mmgqa.dbf . HEER
Fields Vaes
T Shape] N N
] [Station] 32
R 35
[Beginning) [ S > or 36
[End] S, - 40
- 1. Jasph_holes] ot 48
[Asph_crack] : < - 58
[Conc_hales] 65
[Should_edg] L by 68
[Littes_amt] S T s -
{Rock_debri} _'_l : ; s UpdaleVabes e
Arlond movbel. o ’ .
Joute] =15 - L e ENT G
VTSR —~ [ - NewSet . I
aarose |
e Select From Set

Figure 23. Multiple Query Tool.
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Figure 24. Display of Query Results.

Statistics

Statistics of the data are essential for most planning studies. With the database front end or a GIS
like ArcView, tools are readily available to calculate statistical parameters such as standard deviation,
mean, sum, count, maximum value, minimum value, variation, etc. Figure 25 shows the sum, count,

mean, maximum, minimum, range, variance, and standard deviation for the shaded data.
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Figure 25. Statistical Summary for Selected MMQA Data




CONCLUSIONS

The pavement inventory and scheduling needs assessment at the regional level provided the’
information for developing a computer-based tool that could be applied at the local level. The needs at
headquarters for aggregating the data were accommodated by exposing the regional data in standard
(.dbf) formats.

A variety of development tools were considered for the project including: Borland Delphi,
Microsoft Visual Basic, Sybase PowerBuilder, and Symantec Visual Cafe. Each of these tools has its
strong and weak points. After careful consideration, Delphi was selected. We judged that it provides
satisfactory connectivity for enterprise as well as local back-ends, it provides a powerful development
language (object Pascal) for engineering algorithms, and it provides an exceptionally good Integrated
Developers Environment (IDE).

The Pavement Preservation Prototype consists of three coordinated sections: Pavement
Treatments, Paint Treatments, and Maintenance Management Quality Assurance. Each section was
provided with a customized Graphical User Interface (GUI) in conjunction with a standard database back-
end. The GUIs were designed to resemble as closely as possible the forms that were currently in use in
order to reduce the impact of switching to a new system.

Because the data were converted and exposed in a standard format, straight forward ArcView GIS
analyses could be applied. Examples are provided for each of the three prototype sections demonstrating

the advantages of standardizing regional data and applying GIS for analysis and visual displays.
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APPENDIX A

DATABASE TECHNICAL DETAILS
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GENERAL DATABASE

Field name Type
STATION Number
ROUTE Number
BEGIN_MP Number
END_MP Number
LOCATION : Char
ADT_1997 Number
SURF_AREA Number
LAST_CONST Char
ROAD_CLASS Char
STIP Char
LANE_MILES Number
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PAVEMENT DATABASE

Field name Type
STATION Number
ROUTE Number
BEGIN_MP Number
END_MP Number
LST TRE TY Char
LST TRE_YR Number
SCD_TRE TY Char
SCD_TRE_YR Number
PLN_TRE TY Char
PLN_TRE YR Number
LANE_MILES Char
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PAINT DATABASE

Field name

STATION
ROUTE
BEGIN_MP
END_MP
LST PT TYP
LST PT YR
SCD_PT TYP
SCD_PT YR
ACT_PT TYP
ACT PT_YR

LANE_ MILES

44

Type

Number
Number
Number
Number
Char

Number
Char

Number
Char

Number

Char



EVALUATION DATABASE

Field name Type
STATION Nmber
ROUTE Number
BEGIN_MP Number
END_MP Number
EVALUATION Char
CRACK_IND _ Number
IRI Number
RUT _DEPTH Number
SKID_NUMBER Number

COMMENTS Char
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MMOQA DATABASE

Field name Type
STATION Number
ROUTE Number
BEGIN_MP Number
END_MP Number
ASPH_HOLES Char
ASPH_CRACK Char
CONC_HOLES | Char
SHOULD_EDG Char
LITTER_AMT Char
ROCK_DEBRI Char
WEED_CONTR Char
VEG_CONTRL Char
MOWING Char
LANDSCAPE Char
DRAIN_CLEA Char
DRAIN_INLE Char
SLOPE_RE Char
BRIDG_DECK Char
BRIDG_STRU Char
BRIDG_JOIN Char
PAVE_STRIP Char
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PAVE_SYMBO
SIGNS
DELINEATOR
GUARDRAIL
H/W_LIGHT
SIGN_REPA
SWEEPING

GUTER_ISLAND

47

Char

Char

Char

Char

Char

Char

Char

Char
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APPENDIX B

USER’S GUIDE
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USER’S GUIDE TO THE PAVEMENT DATA INTERFACE PROGRAM

Introduction

The Pavement data interface program is an efficient tool for the collection, analysis and retrieval
of data. It consists of several components that are tailor made to suit the current requirements of UDOT
pavement data management.

The program has been modeled after the Quattro-pro spreadsheet programs that are currently
being used. While mirroring the ease-of-use of a spreadsheet, this program has additional advantages. The
database structure developed is used to perform repeated tasks such as querying and sorting with ease. A
GIS tool such as ArcView can access the tables stored in this program. This provides a real time spatial

representation of the pavement data.

Salient Features

The first command to be executed on running the program is the File > Open menu. This leads
the user to the directories on the machine. The user needs to select the correct path the database resides in
and click on any of the tables.

The opening screen shot shows the five different databases which can then be viewed

individually by clicking on the tabs.
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[f22 1 0 10 BOtoGrantsll 2916 =PI N
[ 222 13810 112 GrantsvileManS 4808 731 e
[z 138 m2 204  Guanstviletoyst 29268 2879 I

222 1m0 171 SR1%8t 918 378
e 6 w1 ae 71 ——

b d
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A navigator tool has been provided which allows convenient access to each of the rows in the

database. The buttons have the following functionality.

Moves the cursor to the first row

wwd  Moves to the prior row

owad  Moves to the next row.

] Moves the cursor to the last row.

The File > Print command prints the table being viewed.
The File > Close command exits the program.

The Edit menu brings up a new dialog box which is used to update the databases. The values of
the fields of the row pointed by the cursor are seen in the dialog boxes. A typical dialog box would

resemble the following screen shot.
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¥ Input Interface M=l E3

General Database

Station | Sutface Area |188.?4
RouteIBU Last Construction 11993

Beginni l

eginning J40 Road Class INTER v

Endin I__________
9|s6 STIP .|LH

L \( Knolls to A it

DDalﬂnl nolls to Aragon! Lane Miles l18

ADT(1997) ]8359.2
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Once the requisite changes have been made, the user has a choice of posting the changes or

canceling. them.

The following occurs when the ‘Post’ button is clicked
(a) The record in the main table gets updates with changes made in the dialog box.

(b) The changed record gets archived in a separate archive table.

This two-step approach to updates ensures that a record of all changes made is maintained.

The Add menu items work similar to the Edit menu items with the difference that the Add
commands are invoked when adding a new road segment. A dialog box similar to the edit dialog pops up
which can be populated with the new values.

The Tools > Archives command enables one to view the archived tables. A print option is also
included. Navigation tools have been provided to move through the database. Additionally a tool to delete
records has also been provided to clean up the archived table.

The Tools > Queries tool allows one to query the database. Complex queries are supported by

this program using the ‘and’ or ‘or’clauses. This tool brings up the following screen.
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X Query Tool M= E3
Choose from Table lPaint vI
" Fields Available Values Available
Ismﬂom - _|route | il
E
BEGIN_MP | ME .
END_MP ‘ =] > »=] and = B
LST_PT_TYP : ] 35
5o PT TP ol | «|o]l 4
SCD_PT_YR _— B . . ;
ACT_PT_TYP B
ACTPTYR <] - o
| ROUTE = 15 v GO X Clear ‘

The following sequence of commands has to be followed to query the database.

(a) The table to be queried should be chosen in the drop-down box. In this example, we have chosen the

‘Paint’ table.
(b) The fields available for the table chosen show up as a list on the left-hand side. The user double-

clicks the field to be queried.

(c) The user single-clicks the operand to set the query.

(d) A list of values available is displayed as a list in the right-hand side. The user double-clicks on the
value he needs selected.

(¢) The query as chosen appears on a box below the lists (in the example here; “Route =157).

(f) Clicking on the ‘Go’ button brings up the query results.

(g) Clicking on the ‘Clear’ button resets the query.
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The results of a query can be printed or saved as a new table as shown in the next screen shot.

2 FResult Ni=]

iR Tools . . '
SaveTableAs [E  [BEGIN. MP [END_MP JLST PT TYP  |LST_PT_YR|SCD_PT_TYP ISCD_PT_‘YHIAE:I

Ext o 15, 304 307PANT 1 19 TAPE . 139874
1537 WBEPOXY  18BEPOXY  TS97EP
| 2 15 3108 J2EPOXY 19 EPOXY T EP .

.2 15 32 37EPOXY  198GEPOXY 198 EP
(| s 5 37 318 EPOXY 1395 EPOXY 1997 EP -
| 226 15 318 321.7 EPOXY ~ 19%EPOXY 13 EP -
0 226 15 3217 323 EPOXY 199 EPOXY  1998'EP
| o 15 287 291EPDXY  1SBEPOXY ' 19BEP
(| 22 15 2@ 2 EPOXY 199 EPOXY . 187EP
] 2 15 2% 34EPOXY  19EPONXY  1SEP

The Tools > Sort command is used for multiple sorts on the database. The screen looks like the following

graphic.
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Multiple Sort E3

Choosefrom Table lF’avement v]

Source List Destination List:
BEGIN_MP ROUTE

STATION
LST_TRE.YR _>__| END_MP ,
1sCD_TRE_TY :
SCD_TRE_YR .__l i )
PLN_TRE_TY >> " —
PLN_TRE_YR +
LANE_MILES _<_] —
SURF_AREA ,
COST_TREAT _<l
COMMENTS <
oK Cancel l Help

The following steps are to be followed:

(a) The table, which needs to be sorted, is chosen first.

(b) The source list details all the available fields. Using the right arrow (>), the destination list can be
populated in the order of precedence. The up and down arrows can also be used to determine the sort
order. The double-right arrow (>>) can be used to transfer the entire source list to the destination.

(c) The ‘OK’ button gives the sorted table which can be printed and saved as a new table.
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The Print command on all these screens lead to the following dialog box.

{ ~ Print Preview
41649 - Generd
STATION [ROUTE  IBEGIN MP TEND MP LOCATION DT 1997 [SURF ABEA
221 [fi] ] ‘l 54 Tooele Courty 122148 1783 tetsttt
221 a0 0 evadalive toBP 7846.2 1093 1937
221 80 10 20 ast of Wendover 78354 74.44 1996
221 a0 20 30 \Wendover 7835.4 5 1995
221 80 30 40 30 to Knolls 7835 4 Fia) 1994
221 80 40 1) nit 8359.2 16674 1933
222 T 3 66.4 ils et tol-80 13284 12.49
222 80 58 £9.4 1aqoniteto Lowe 83862 4.2 198L
222 80 594 89 oweto Burmster 9460.8 16288 1988
222 a0 39 94 6 wimster to End of 42 1988
222 80 94,6 97.1 nd of Concrete t 9612 18.75 1971
222 80 97.1 102 ke Point to Blac 273618 {4421 1991
222 138 0 10 -80 to Grantswill 2918 2925
222 138 10 11.2 GrantsvilleMain S 4806 231
222 138 112 20.4 GranstvlietoJct 926 8 2879
222 96 0 1721 SR-199to 918 378
222 96 17.1 24.4 17.1
222 96 24.4 28,4 337
222 198 284 36.89 tol-80 1463.4
223 36 5.4 14.2 uzb County to Lof

1 Pagelof8 = | 100% |  MSSansSerfBpt |

The print tool contains standard features such as zooming the preview, setting up the paper size and

properties such as landscape and portrait. All these dialogues are in the standard windows format.
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APPENDIX C

MMQA DATA DESCRIPTIONS
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% 1|1 8 | ¢ |-pb [ e | F | &6 ] wHW | vty 1 K ]

ABOUT MAINTENANCE MANAGEMENT QUALITY ASSURANCE SCORE CARD =]

‘Bt S;ave

Ext Wihout Saving I

1
2 | The spread sheet was developed to help Station personal to Input Score CardWorksheétData;Il
3° | The intention was to create a user friendly spread sheet which would help stations compile the MMQA
4| Statistical Data. The spread sheet uses dialeg sereens to help contro! the data input and calulations.
5| This page is the focal point of the spread sheet, it uses push buttons to allow the user to manipulate the
“'§ | spread sheet without concern for the how why,and when questions which arise form spread sheet usage.
7
8 " EditRecord ll Wite Region Statistics‘l PRINT STATION SUMMARY ‘I
g MI Wits Finishad Rand mll ‘Backup slatibn Activity Défa [‘.txt]ll
View Record ]I Tt T B | o .
10 CPRINT ;Wxi.tes File ~]mpaort Station Activity Text File lJ
-—————————J_ ] <starion>done. 1 to the
n PRINT Route Repor ]I MMQA directory on __ResetStation |
12.
13 l For first time use create the directory C:\MMQA\ with Windows Explorer ~Showme - I
14 | STORE THIS FILE IN THE DIRECTORY [C:\MMQA] BEFORE 5TA .
Spreadsheet stores all files into the above directory.

~ MMOA Program Service Level Worksheet

il ‘ Sl Tum Piint DI/ On
Entry Dae: Station: 1421 (9 PRINTON

. 3-] *l= g9 : O PAINT OFF
e 2 E] 13j 999: Region/Distrcit: Region 1 i : S

o Semple Paviod ——
Area: CLNTON O SPRANG

Numhrofham:‘l_z—ﬂ ‘ S @FAU-:[ g

Poute -Random number —
Frute 37 Bandom 0.10
:.| Route 37 Random 0.80
Route 37 Random 2.20
Route 37 Random 7.60
Route 37 Random 9.20
Route 39 Random 0.80
Route 39 Random 1.30
Route 37 Random 0.40

Evaluator:: |

" Genersl Comments|.
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Score Card Input

Maintenance Program Service Level Worksheet
View Group Thiesholds for : |8

" Group 2= HARD_SURFACE MAINTENANCE —— ]
Defective Ameilnial Azewn
NUMBER ACTIVITY » s :
2A% Asphalt Pavement Palching & lepail ) o 0 ::]I 02 )
Ruting [>1/4") ‘ - ~ o o 1056

Y Crack seaing & chipseal e e
281 i Concrete Pavement patching & repair N ‘ o #4502 .
8 - NON-HARD SURFAG MAINTENANG

NUMBER T ACTIVITY ; ‘ ‘
341 o Shoulder Work i -:—-E 106

EpiT > IR

Previous |

Maintenance Program Service Level Worksheet
View Group Thresholds for :ﬁ—— .

Group 4 = ROADSIDE MAINTENANCE

NUMBER . ACTIVITY
4a1 Litler‘pi‘ckup\

42 Pockremoval

" Group'$ < VEGET ATION CONTROL

NUMBER CaciviTy
BAl ¢ Nq@s\f/eedﬁqmo[

52 | v;geiaion Contiol

5A3 ‘ : Mowmg[Nu«sanceVe‘ C

eiT > JEE o
[ Group 2 - HARD SURFACE MAINTENANCE
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Score Card Input :

Maintenance Program Service Level Worksheet
View Group Thiesholds lorfe_—

Group 6 - DRAINAGE _SLOPE REPAIR
NUMBER ACTIVITY ) : ‘| Defective Ameulistal Ameunt

6a1 Grade & clean ditche 0 j 0 ﬂ
BA2 Maintain inlets ok {0 = ;‘0 = k
i SB‘I‘ ’ ‘ ‘Elosionﬂepair{ ] ‘ g . ‘ =10 :::‘ o] i]

EDIT >

Group 2 - HARD SURFACE MAINTENANCE ;
Group 3 - NON-HARD SURFACE MAINTENANCE

_Next Previous |
Group 4 - ROADSIDE MAINTENANCE i ’

Score Card Input
; Maintenance Program Service Level Worksheet

: View Group Thiesholds fo!

" Group 8 - TRAFFIC SERVICES S

N . NUMBER  ACTMITY
81 *- Pavement Stipping

842
8A3

Pave\meﬁk markhgg o
: reﬁ;m lﬂklg['alac; signs ] b
Y I Repair and Replace delin?ator
845
BAB

Guardrail maintenance

Highway lighting maintenanc

8A7 Signai quair

8AB Sweeping

849 Curb/gutter & Island

BMU‘ - Runaway tiuck lanes

EDIT M ‘!
Group 2 - HARD SURFACE MAINTENANCE
Group 3-NON-HARD SURFACE MAINTENANCE <]~ Next ] PmsousJ
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e

SCORE CARD:AT &

|

G‘}

ALl B l c | o [ e | ¢ | o ! |
[ ] MMQA Program Service Level Worksheet
2
3 Date_: 02213199 Rowte : 37 Estry Dat 02713199
4 | Region: 1 No. of Lames : 2
5| Area..: CLINTON
6| Station: 1421 Mile MarkerBegi 0.10 MM Eading: 0_20
3 —_— ———
[ Segment length(mi} = 0.10
2
10
1
12 | nUmBER ACTIVITY I CONDITION I L0s I Los# | Defective I uniez | ToN I . Units |
RATING Amount Amount
13
14 |Growps 2 - HARD SURTACE MAINTENANCE
Azphalt Pavement Patching & repair w8 & B8 of -
15 2A1 (PotholesiRutz) 0.00 1.4 potholes 0.2 # 1anes®0.10
16 Rutting (>174") 0.00% o4 At 1.0 Lin. Ft. 1056 8 lanes"528
17 2A2 Crack zealing & chip seal 0.00 Lca ht 13 Lin. Ft. 0.2 & lanes"0.10
. . Lin. ¥E.
an 281 Concrete Pavement patching & repair 0.00 Lod &+ 13 spalied 0.2 #tane2"0.10
(crackstjoints) ca
19
20
21 jcreup 3 - HOH-HAND SURFACE MAINTIMANCE
22 a1 ] Shoulder Work | 0.00% | wea | 15 | [ LinFe | 1056 } 2525 ]
23
24
. 25 Group 4 - FOADFIDE WMRINTENANCE
2% 4A1 Litter pickup 0.00 108 A+ 1.1 # of 0.10 ClLmi.
objects
27 | A2 Rock removal 0.00 o8 & | 1.1 k.| o0 cL mi.
28
29 |Grawp § - VEGRTIATION CCNIROL
30 SA1 Moxiouz Weed Control -1.00% od Nk 1.0 Lin. Ft. Lin, Fr.
31 SA2 Yegetation Control -1.0 Log ¥/A 15 Lin. Fr. Lin. Ft.
3 SA3 Mowing(Nuizance Yeg. Control) -1.0% Lod H/A 10 Lin. Ft. Lin. Fr.
33 B Landzcape Maintenance 0 Lod ¥ik 10 Sen condition dezcription matrix 581
34
a5 Crawp & - DRAINACE a SLOIT RRPAIR
36 6A1 Grade & clean ditches -1.0% Loa Nk 1.0 Lin. Ft. Lin. Fe.
a7 6A2 Maintain infets -1.0% 08 AN 1.0 ¥ of inlets Total # of infets
> 25% full
38 681 Erosion Repair -0.2 108 H/K 1.0 Lin Ft. Lin. ft.
39
47 | Gxoup 8 - TMJSTIC SRRVICIE
48 8A1 Pavement Striping -1.00% 108 KiR 1.1 Lin. Ft. Lin. Fr.
49 &M2 Pavemaent markingz -1.00% 108 ¥R 1.1 #of.. Total 8 of ..
50 B8A3 repair & replace signz -1.00% o4 ¥/A 1.1 #of.. Total # of ..
51 SAd Repair and Replace delincators -1.00% 104 Nk 11 Bof.. Total # of ..
52 8AS Guardrail maintenance -1.00% od Nk 1.0 Lin. Fe. Lin. Fr.
53 8AB Highway lighting maintenance -1.00% 108 ¥iA 1.0 Bof.. Total # of ..
N . #of
- rod /A 3
54 8AT Signal Repair 0.01 2 15 Calloutz # of year.
85 8AS Sweeping -1.00% Loa ¥k 1.0 Lin. Ft. Lin. Ft.
56 8A9 Curbigutter & Izland -1.00% od /A 1.3 Lin. Ft. Lin. Ft.
57 8A10 Runaway truck lanez -1.00% 09 Wik 1.0
63
64 Grawp 10 - FXAT AREA MRINTENANCE
65 10A1 I rest area maintenance ‘ -1 | | 1.0 [ See Condition Description Matrix 1041 l
66
67
65 Rvaluatar
69
70
71 | Comments:
reshol resho resnol Pasno reshol nes

«[ <] 3] »| >\ SCORE CARD
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Group Center

-1
0
1

1.33
1.34

1.67
1.638

2
2.01
2.34
2.35
2,67
2,68

3.01
3.34

3.35
3.67
3.68

4.01
4.34
4.35
4.67

4.68

5.01
5.34
5.35

5.67
5.68

NiA

A
A

A
A
A

A

e

Be

Bs

B-

C+
Ce
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A B c o jve e | 6 | M ! s 1 x L Ml N
3
4 Randoms generated by Region 1...10/14/88 ..
5
Station ¢/ j
6 Random| 1421 1422 1423 1424 1425 1426 1431 1432 1433 1435 1438 1437
.4 .
7 ROUTE 1 37 205 90 []0] 39 [ L) 13 13 23 23 10
8 IREF. Marke 7.680 1.40 0.30 4.00 18.40 15.10 1.70 11.80 32.00 3.70 19.80 12.50
9 ROUTE 2 37 26 315 B0 39 B85 84 13 13 23 23 18
19 |REF. MArke 2.20 2.60 1.00 §.20 19.20 18.60 14.90 10.30 30.30 7.70 26.50 2.60
11 ROUTE 3 37 26 13 89 39 65 84 13 13 23 23 168
12 |REF. MAcke 0.80 1.10 7.40 344.30 38.60 20.70 5.40 12.40 27.10 1.80 28.60 13.50
13 ROUTE 4 37 39 13 89 38 85 84 13 13 23 30 16
14~ [REF. MArkef 0.10 3.70 6.00 337.00 40.80 9.00 4.70 18.60 22.20 8.30 111.00 18.60
15 ROUTE [ 37 39 13 ] 349 [ 84 13 13 23 30 16
16. . |REF. MArke: 9.20 5.30 5.00 339.00 | 11.00 15.50 9.10 18.80 256.70 42.10 ] 14300 | 13.00
17 ROUTE B 39 53 13 89 39 86 84 82 13 23 30 16
18~ |REF. MArkel 1.30 0.80 3.20 34240 | 15.00 20.80 8.00 4.30 26.80 8.00 110.20 5.90
19 ROUTE 7 39 53 13 89 38 4] 84 82 30 23 30 18
20 - |REF. MArke 0.80 0.30 1.40 33560 | 20.00 14.50 0.30 0.30 99.20 1580 | 109.10 | 21.20
-2 ROUTE 8 97 79 91 88 38 65 84 82 30 23 61 168
22 |REF. MArke 1.80 440 7.30 340.20 | 22.90 13.10 3.00 2.10 102.20 0.30 2.80 24.00
23 ROUTE [ 97 79 91 108 39 65 84 83 30 Q1 61 18
24 . IREF. MArke 0.40 0.30 8.30 10.30 16.70 10.30 17.30 25.00 99.30 11.30 5.10 23.60
25 ROUTE 10 98 79 91 106 158 05 84 83 30 91 61 18
26 {REF. MArke 1.30 1.10 5.20 790 10.30 12.50 16.20 Z7.80 | 98.80 20.60 420 190
27 ROUTE 11 98 89 g1 106 158 B85 84 83 30 91 89 30
28 {REF. MArke 0.50 350.70 4.70 B8.70 9.50 17.70 7.10 18.00 100.00 14.10 381.20 | 1268.20
29 ROUTE 12 [ 89 81 106 158 66 84 83 30 91 80 30
30 |REF. MArke 2.90 357.30 1.70 7.30 8.30 11.00 19.50 26.50 | 103.10 | 17.80 | 372.80 [ 122.80
31 ROUTE 13 103 88 91 108 158 66 30 83 38 81 89 30
32 " [REF. MArke 0.00 357.00 9.00 2.00 2.40 5.80 71.00 16.10 8.20 16.00 | 378.40 | 1198.60
33 ROUTE 14 107 88 91 109 158 68 30 83 38 81 88 30
34 |REF. MArke 3.80 353.50 8.20 0.10 3.70 2.50 38.40 23.40 17.80 1400 | 392.80 [ 136.00
35 ROUTE 15 108 89 88 108 158 68 30 83 38 81 89 30
36 [REF. MArke 3.20 359.30 | 370.10 2.60 8.00 12.30 48.50 30.60 8.40 12.00 | 402.70 | 117.50
37 ROUTE 16 108 1] 168 158 66 30 102 38 91 g1 30
38’ IREF. MArke 11.70 | 346.60 | 3686.80 0.10 11.00 8.30 22.10 16.10 2.00 22.50 4450 | 120.00
39 ROUTE 17 108 104 89 168 158 66 30 102 38 101 81 30
40 - [REF. MArke 1.60 2.90 368.90 0.80 6.80 13.30 4.80 170 4.80 18.90 2730 | 130.50
Uit ROUTE 18 108 104 88 168 158 66 30 102 38 101 91 128.2
42 |REF. MArhe 6.90 1.10 365.80 0.30 11.30 8.10 25.60 8.50 12.40 14.50 37.00 30.00
43 ROUTE 19 108 203 193 167 66 30 102 81 101 91 1325
44 |REF. MArke 7.50 3.10 362.80 5.30 3.00 14.50 20.10 5.40 1.680 12.60 35.50 30.00
45 ROUTE 20 108 203 89 103 187 66 30 102 81 101 91 30
45 [REF. MArke 8.40 2.60 371.60 0.10 4.30 9.10 73.20 6.00 240 14.40 33.40 | 141.60
A7 ROUTE 21 108 203 83 163 1687 66 30 102 102 101 142 39
48 :|REF. MArke 12.50 2.40 8.20 3.50 2.20 12.30 17 .00 3.00 17.80 8.20 12.50 67.70
49 ROUTE 22 110 204 83 193 167 66 30 102 102 101 142 39
50 . IREF. MArke 1.30 480 10.60 3.00 1.60 8.30 43.60 4.80 19.70 16.60 14.30 82.30
51 ROUTE 23 110 204 83 225 167 84 30 102 102 101 142 30
.52 ~|REF. MArke 270 2.30 0.00 0.80 0.60 103.30 | 66.40 2.40 18.20 21.20 8.80 67.50
53 ROUTE 24 110 235 83 227 167 84 30 15 102 101 142 38
54 IREF. MAske G.10 0.20 7.40 0.60 520 105.80 | 32.20 | 377.70 | 18.80 19.50 2.90 45.60
55 ROUTE 25 127 235 83 232 167 84 30 15 240 165 200 39
56 |REF. MArke 9.60 1.20 4.50 1.70 6.80 401.00 [ 1370 | 377.00 0.10 2.60 1.00 51.20
57 ROUTE 26 127 235 83 232 167 84 30 15 240 165 248 38
58 |REF. MArke 7.30 2.00 6.80 0.00 8.70 104.80 2.30 380.40 1.00 4.40 8.00 47 .20
=g ROUTE 27 134 15 83 232 167 84 30 15 15 165 218 39
60 [REF. MArke: 4.20 341.90 2.20 2.20 7.70 96.40 1.00 375.30 | 400.90 9.20 7.30 48.30
61 ROUTE 28 134 15 15 232 226 84 42 15 15 165 218 88
62.:: IREF. MArske 2.80 344.20 | 3686.40 0.60 1.80 ©90.20 290 378.10 | 383.00 8.70 270 410.80
83 ROUTE 29 134 15 15 15 226 84 42 84 15 165 218 89
84 IREF. MArke 12,30 | 347.30 | 370.10 | 33860 3.50 102.30 1.60 31.10 | 399.60 4.80 5.30 408.20
[ ROUTE 30 134 15 15 15 226 84 a2 84 15 185 237
86 . |REF. MArke 7.9 353.30 | 334.20 | 330,80 2.30 92.90 3.80 32.60 | 398.90 9.60 0.40 412.90
57 ROUTE 31 126 15 15 15 226 84 a2 84 15 165 237 88
.68 |REF. MArke 15.2 346.00 | 365.40 | 332.70 0.10 95.680 6.80 30.50 | 387.30 6.50 3.70 406.10
69 ROUTE 32 126 84 15 15 226 84 42 84 15 238 237 88
70 |REF. MArke [1] 87.00 [ 360.90 | 334.90 1.10 100.40 0.80 38.8C | 381.00 3.80 240 415.80
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108 Mile marker 7.8
98 Mile marker 0.5
134 Mile marker 12
39 Mile marker 0.8 °
126 Mile marker 6.
37 Mile marker 9.2
110 Mile marker 2.’
127 Mile marker 7.
126 Mile marker 0.1 ;-

37 Mile marker 0.1 ~[

Cran‘cel”kzli : Hélﬁ ]

I Macro Menu
Group 2 - HARD SURFACE MAINTENANCE
Group 3 - NON-HARD SURFACE MAINTENANCE
Group 4 - ROADSIDE MAINTENANCE

Group 5 - VEGETATION CONTROL
Group 6 - DRAINAGE & SLOPE REPAIR
Group 8 - TRAFFIC SERVICES o
Group 10 - REST AREA MAINTENANCE
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Score Card Input
- Comments | * Maintenance Program Service Level Worksheet
i Viaw Group Tiwesholds | :;:i

Group 3= NON-HARD SURFACE MAINTENANCE

NUMBER o acTvITY Defective Amadatal Amount

o e e om |

U Edit View
. Cancel
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